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This file lists all changes made to ETABS since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are deemed more significant. 

 

Changes from v15.0.0 (2015-02-23) 

User interface 
Enhancements Implemented 

* Incident Description 

 78112 An enhancement was made by adding a Select/Deselect All button to the Check Model Form. 

Graphics and Drafting 
Enhancements Implemented 

* Incident Description 

 79302 An enhancement has been made so that the graphical zoom level is no longer changed when 

performing certain operations, such as setting building view limits, hiding or un-hiding grid lines 

from the current view, or moving through the elevations using the arrow buttons. Previously these 

operations caused the view to zoom out to show the full model. 

 81221 Two enhancements have been implemented to make drafting easier:  (1) An option has been added 

to "Draw using Snaps Only".  (2) An option has been added to show colors by story. 

Modeling 
Enhancements Implemented 

* Incident Description 

* 14367 A new two-dimensional concrete model has been added to the nonlinear layered shell. This model is 

based on the Darwin-Pecknold model, with consideration of Vecchio-Collins behavior. This model 

represents the concrete compression, cracking, and shear behavior under both monotonic and cyclic 

loading. The direction of cracking can change during the loading history, and the shear strength is 

affected by the tension strain in the material. The given material stress-strain curve is simplified 

internally to account for initial stiffness, yielding, ultimate plateau, and strength loss due to 

crushing. Zero tensile strength is assumed. The layered shell allows this material to be used for 

membrane and/or flexural behavior and to be combined with steel reinforcement in arbitrary 

directions and locations. Transverse (out-of-plane) shear is assumed to be elastic. 

* 27098 The specification of the notional size used for time-dependent creep and shrinkage analysis has been 

enhanced to now be specified with the frame and shell section properties instead of with the 

material property. This now provides three options:  (1) "Auto", in which the notional size will be 

calculated automatically based on the section dimensions, when applicable.  (2) "User", in which the 

user specifies an explicit value to be used for the section.  (3) "None", in which creep and shrinkage 

is ignored. Models from older versions that used the notional size in the material property will be 

updated so that each frame or shell section uses the previously specified value from the material as a 

"User" value in the section definition. Models from older versions that used material overwrites may 

produce different creep or shrinkage results if the notional size in the material overwrite assigned to 

a frame or shell object is different from that in the material used by the section assigned to that same 
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* Incident Description 

object. Identical results can be obtained by manually adding new sections with the notional size 

value equal to that in the material overwrites, and assigning them to the affected objects. 

* 61923 Time-dependent material behavior has been expanded to include the CEB FIP-2010 and ACI 209R-

92 codes, as well as to support user-defined curves. Time-dependent behavior includes creep, 

shrinkage, and stiffness aging during staged-construction analysis. 

 78111 An enhancement was made for the specification of diaphragm mass eccentricities in the definition 

of the mass source. Previously the eccentricity was specified as an eccentricity ratio and an angle. 

This has been changed to instead specify independent eccentricity ratios in the X- and Y-directions. 

The effect of this is to give a more elliptical shape to the generated locations of the diaphragm 

centers of mass with respect to the direction of movement. This will have no effect on models that 

only move the diaphragm center of mass parallel to the global axes, which is the most common 

case. However, results may change from previous versions of ETABS for models where the center 

of mass was moved at an angle to the global axes. In either case, the most meaningful results will be 

obtained if the global axes are aligned with the principal inertial axes of the structure. This 

enhancement only affects the movement of the center of mass using mass source definitions, which 

is not common. It does not affect eccentricities defined in lateral load patterns or response-spectrum 

load cases. 

 

Loading 
Enhancements Implemented 

* Incident Description 

* 81620 Automated response-spectrum functions have been implemented for the following codes: Costa 

Rica Seismic code 2010, Ecuador (NEC-SE-DS 2015), Mexico (CFE-93 and CFE-2008), and Peru 

(NTE E.030 2014). 

* 81621 Automated seismic loading has been implemented for the Dominican Republic R-001 code. 

Analysis 
Enhancements Implemented 

* Incident Description 

* 75659 A new stability check has been added for nonlinear static load cases. For force-controlled load 

cases, including staged construction, the stiffness matrix will be formed, solved, and checked at the 

final converged state for negative eigenvalues. The number found will be reported in the analysis 

log file (.LOG), and a stability warning issued in the log file if the number is greater than zero. 

Displacement-controlled load cases are not checked as these typically are used to analyze unstable 

structures, whereas force-controlled load cases are intended to be stable. 

* 79573 The speed of nonlinear static and nonlinear direct integration time-history analysis has been 

increased for models containing many linear shell elements. 

Composite Beam Design 
Enhancements Implemented 

* Incident Description 

 76726 

77928 

Several enhancements were implemented that affect beams that are part of a composite-beam design 

group:  (1) The “Show Group Results” option is now unchecked when the Interactive Composite 

Beam Design Review form is first displayed.  (2) If the user subsequently checks the box “Show 

Group Results”, a series of progress messages will be displayed while ETABS evaluates each of the 

various alternative designs for each of the beams in the group.  (3) if no acceptable design can be 

found for the composite beam that is being designed interactively, the “Show All Alternates” mode 

is automatically entered, and the “Show Group Results” check box is unchecked and disabled.  (4) 

When the user chooses a new design for the beam, the confirmation form now includes a warning if 

the design does not work for some other beam in the design group. 

 80841 Three enhancements to the composite beam design output were added:  (1) When design is 

controlled by a strength capacity other than the positive flexural capacity under service conditions, 
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* Incident Description 

the loading of the beam is listed for both the load combination which governs the design and the 

load combination which controls the positive flexural demand under service conditions. Previously 

only the loading for the latter condition was listed.  (2) Loads of type "Other" are now reported 

when present in the beam loading.  (3) Some intermediate stations at which no change in loading 

occurred were occasionally being listed in the output. These are no longer listed, for conciseness. 

 

Results Display and Output 
Enhancements Implemented 

* Incident Description 

* 61275 The display of plots and tables for the results of modal time-history load cases, particularly FNA 

load cases using many modes, has been made significantly more efficient. This will reduce the time 

taken to produce displacements, stresses, and forces, including story shears and other types of 

section-cut forces. 

 66225 An enhancement has been made to optionally show the plot of a time-history function when an AVI 

animation is created for a time-history load case. 

 78993 The cyclic animation option for the deformed shape, as well as the cyclic option for videos 

(command File > Create Video), have been enhanced to present a smoother motion in time. In 

addition, the video feature now defaults the size to the active window, and the animation rate 

(frames per second) has been corrected. Previously the video rate was one frame per second 

regardless of the user-specified value. 

 81220 An enhancement has been made to better synchronize the music with the animated deformed 

shapes. 

 
Application Programing Interface (API) 
Enhancements Implemented 

* Incident Description 

 76669 An enhancement was made to the ETABS API, implementing functions to set, get, and delete pier 

and spandrel labels, as well as assign the labels to frame and area objects. 

Installation and License 
Enhancements Implemented 

* Incident Description 

 80321 All significant installed EXE and DLL files are now digitally signed to avoid sand-boxing and other 

interference from anti-virus products. It is important to note that there never was a threat from any 

of the installed files in any previous release, but a few anti-virus products are overly cautious, which 

could cause them to prevent the software from running. No results were affected. 

Miscellaneous 
Enhancements Implemented 

* Incident Description 

 78152 The version number has been changed to v15.1.0 for a new intermediate release. ETABS v15 will 

be known as "ETABS 2015".   
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User Interface 
Incidents Resolved 

* Incident Description 

 71779 An incident was resolved where closing the Model Explorer affected the ability to resize the 

Properties of Object form used for drawing. No results were affected. 

 75023 An incident was resolved where abnormal termination errors could occur when area objects having 

invalid joint coordinates were present in the model. Such illegal area objects are now removed from 

the model when the file is opened. 

 77660 An incident was resolved where some forms were not properly scaled, including the size of internal 

fields and/or the size of the fonts, on certain machines, particularly at higher resolutions. No results 

were affected. 

 78028 An incident was resolved where the software would sometimes go into an infinite loop of error 

messages if the story response plot window was active when the model was unlocked. Results were 

deleted as expected, but the software had to be terminated externally and restarted. The model was 

unaffected. 

* 78047 An incident was resolved where an abnormal termination error could occur in certain cases when 

trying to display plot functions again after previously displaying them and then closing the 

corresponding plot window. In addition, defining certain combinations of plot functions and then 

saving the model could corrupt the model file (.EDB), which then could not be reopened in ETABS. 

When this occurred the model could be recovered by importing the corresponding text file (.E2K or 

.$ET). This was not common. 

 78079 

81672 

An incident was resolved where the up/down buttons to cycle through the stories in a plan view 

would not function properly when multiple towers were present. No results were affected. 

 79301 An incident was resolved where certain walls objects could not be selected on-screen in some 

views. This was a user interface issue only. 

 79757 An incident was resolved where certain Define menu items (such as properties) would cause an 

error if the user named the item "None", which is a reserved name indicating the absence of an item. 

The user can no longer name those Define menu items "None". 

 81538 An incident was resolved for the Model Explorer tree where selecting “Frame Load Assigns”, 

“Shell Load Assigns”, or “Frame/Pier/Spandrel/Link Forces” from the Display tab would produce 

forms that were too small to utilize on certain Windows 8 machines. No results were affected. 

 81740 An incident was resolved where using the command Edit > Edit Stories and Grids Systems to add 

stories to a model already having wind or seismic loads defined could results in an Abnormal 

termination, depending upon the order of operations performed. When this occurred, results agreed 

with the model as re-opened or re-imported. 

Drafting 
Incidents Resolved 

* Incident Description 

 74766 

80768 

81540 

An incident was resolved where the command Draw > Draw Floor/Wall Objects > Draw Wall 

Opening was not working properly when the display units were different from the database units. 

When this occurred, the results were consistent with the objects as actually drawn and visible in the 

model. 

Graphics 
Incidents Resolved 

* Incident Description 

 76782 An incident was resolved where switching to the DirectX graphics mode would result in an error 

message on certain machines having adequate graphics hardware when running the 64-bit version of 

ETABS. 

 78511 An incident was resolved where the wall section was not visible in plan view at a reference plane 

when the wall was being cut by the reference plane. No results were affected. 
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Modeling 
Incidents Resolved 

* Incident Description 

 77407 An incident was resolved where the software could terminate when trying to generate a spectrum-

matched time-history functions when both the reference time-history function and the target 

response-spectrum function had a very large number of data points. Now instead an error message is 

returned when a new time-history function cannot be generated in such a case. 

 77929 An incident was resolved where abnormal termination errors could occur when an illegal area object 

having only two joints was present in the model. Such illegal area objects are now removed from 

the model when the file is opened. 

Loading 
Incidents Resolved 

* Incident Description 

 78856 An incident was resolved for Eurocode 8-2004 auto seismic load patterns where selecting the 

Country as Singapore and changing the Ground Type was not updating the Soil Factor (S), and 

Spectrum Periods (Tb, Tc and Td). 

 80131 An incident was resolved for the automated response-spectrum function for code "Colombia NSR-

10" where the Importance Factor "I" used to calculate values of "Sa" was being taken as 1.0 instead 

of the expected 1.25 when the "Group of Use" was set to 3. Results for other values of "Group of 

Use" were unaffected. Results agreed with the function as generated and displayed. 

* 81499 An incident was resolved where the self-weight could be incorrect for models containing the 

SidePlate type of moment-frame beam connections when the model had database units for length in 

units other than inches. 

 81688 An incident was resolved where the ground type specified by the user in the form for the Eurocode 

8-2004 response-spectrum function was not being saved, but was instead always using the default 

value of "B". This value "B" was shown in the tables and reports, and results were consistent with 

this value. 

Analysis 
Incidents Resolved 

* Incident Description 

 74604 An incident was resolved where the analysis was unable to run using the advanced or multi-

threaded solvers on certain machines that use an AMD CPU chip branded as APU (accelerated 

processing unit). Such machines are not commonly used for engineering purposes. When this 

occurred, results were not available. If the analysis was run in the GUI process (typical for smaller 

models), a message was shown and the software was closed. If the analysis was run as a separate 

process (typical for larger problems), only the analysis was terminated and the user could continue 

working with the model. This error did not affect analyses run using the standard solver. Setting the 

environment variable MKL_DEBUG_CPU_TYPE = 2 using the Windows Control Panel before 

starting the software could be used to avoid this error, but this is no longer required with the new 

version. 

* 75749 An incident was resolved where, in certain rare cases, the shell forces used to calculate story forces, 

base reactions, and section cuts could be incorrect for a linear load case that used the stiffness from 

the end of a nonlinear load case that included P-delta effects, including linear load cases using the 

automated P-delta option based on loads. When this occurred, the error was generally large and 

obvious. This was not common. 

 76102 An incident was resolved where the analysis could fail to complete when running multiple load 

cases that used different mass sources in the same run. When this occurred, no results were not 

available. Any results from successful runs were not affected. This error was not common. Only 

v15.0.0 was affected. 

* 77488 An incident was resolved where link elements of type "Damper - Exponential" could add negative 

stiffness to the structure in a nonlinear modal time-history (FNA) load case if it was based on mode 
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* Incident Description 

shapes from a modal case that used the stiffness from the end of a nonlinear static or nonlinear 

direct-integration time-history load case. This included modes calculated using the Preset P-delta 

option "Iterative - Based on Loads". When this occurred, the effect was generally obvious, and was 

more pronounced for larger stiffness values used in the damper property. This affected versions 

13.2.0 to v15.0.0. 

* 77939 An incident was resolved where the results of linear direct-integration time history analysis with 

stiffness-proportional damping could become unstable for models with spring supports. When this 

occurred the error was obvious because the displacement, force and stress results would diverge and 

become unrealistically large. Models without spring supports were not affected. Note that spring 

supports could be automatically created for frame or wall objects containing hinges and that are 

connected to restrained joints. This error affected version 15.0.0 only. 

* 78311 An incident was resolved where the stiffness used for the iteration of frame and/or wall hinge 

response during nonlinear modal time-history (FNA) analysis could be incorrect if (1) the modes 

used for the FNA analysis were calculated from zero initial conditions, and (2) the FNA analysis 

was run after another FNA load case but not continued from that previous case. When this occurred, 

the iteration could be slow, fail to converge, or even converge to the wrong results. This error did 

not occur if the FNA load case was run after solving other linear or modal load cases starting from 

zero initial conditions. This error did not affect FNA load cases that used modes calculated using 

the stiffness from a nonlinear static or direct-integration time-history load case. This error did not 

affect FNA load cases that had link elements but no hinges. 

 78685 An incident was resolved where the model would remain unlocked and results were not available 

after running the analysis in certain cases when multiple versions of ETABS were present and run 

on the same machine. This could be resolved by turning off the auto-sandboxing feature of the 

certain antivirus products before running ETABS. No results were affected. Affected versions were 

v13.0.0 to v15.0.0. 

Frame Design 
Incidents Resolved 

* Incident Description 

 73630 An incident was resolved for steel frame design in which auto-select sections were not being 

utilized as expected for certain models in which a regular section shape (i.e. I-section, angle, etc.) 

was assigned to frame members and later the section property was changed to an auto-select list. 

This affected all steel frame design codes. 

* 78232 An incident was resolved for concrete frame design where the command Design > Concrete Frame 

Design > Verify All Members Passed always reported that all members passed even when several 

members were over-stressed, as indicated by being displayed on the screen in red color with the 

message "O/S". This was an error only for this specific command, and did not affect the design 

results as displayed on the screen, in the tables, or in the individual member design reports. 

Composite Beam Design 
Incidents Resolved 

* Incident Description 

 76726 

77928 

Two incidents were resolved affecting composite beam design.  (1) An issue was resolved where 

attempting to interactively design a composite beam that was part of a composite-beam design 

group containing a large number of beams could cause an abnormal program termination before the 

Interactive Composite Beam Design Review form could be displayed.  (2) An issue 

was resolved where, when an auto-select family included several sections with the same weight, 

only one of those sections was shown in the list of available designs. Neither of these issues affected 

the availability or the validity of composite beam designs obtained in automatic, non-interactive, 

mode. They affected ETABS versions 13.2.0 through 15.0.0.   

 80841 Two issues were resolved that affected composite beam design output with all codes:  (1) The 

controlling demand-capacity ratio was not being reported for the case where the section was 
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* Incident Description 

inadequate in negative flexural capacity when the design was controlled by construction conditions 

instead of service conditions. For such beams, failure was correctly reported but the corresponding 

construction demand-capacity ratio was not being listed. This was a reporting error only and the 

design was not affected in any way.  (2) The live-load reduction factor was mislabeled in the output. 

A ratio between 0 and 1 was being reported but labeled as "%". Now a percentage between 0 and 

100 is being reported. This was a reporting error only and design was not affected in any way.  

Shear Wall Design 
Incidents Resolved 

* Incident Description 

 78359 An incident was resolved for Shear Wall design for C&T type design where area of reinforcement 

indicated by "AsLeft" and "AsRight" were sometimes incorrectly reported in the table "Shear Wall 

Pier Summary". Specifically, for multi-leg shear walls, the values reported for the bottom were the 

same as for the top; the top values were correct but the bottom values could be incorrect. This was 

reporting issue in tabular format only and other design results were not affected. The design report 

via right-button mouse click and the Project Report were correct and not affected. 

 80864 An incident was resolved for shear wall design where the table “Material Properties” in the spandrel 

design report could show incorrect material properties. This was just a reporting issue and design 

results were unaffected. 

Results Display and Output 
Incidents Resolved 

* Incident Description 

 81428 An incident was resolved where the shell stresses for area objects with layered-shell section 

properties failed to plot, the database tables returned zero stresses, and the corresponding API 

function cAnalysisResults.AreaStressShell() failed to return results. Shell layer stresses were not 

affected, nor were shell resultant forces and moments. Area objects with homogeneous shell section 

properties (thin, thick, and membrane) were not affected.  

Database Tables 
Incidents Resolved 

* Incident Description 

 77827 An incident was resolved in which the Section Cuts database table reported the Design Angle as 

zero for design section cuts even when it was defined as non-zero. This was a reporting issue only 

and did not affect section cut results. 

 

Data Files (.EDB, .E2K, .$ET) 
Incidents Resolved 

* Incident Description 

 79238 

80535 

An incident was resolved where an "Error saving Model" message was given in some rare cases. 

This was due to data corruption of User-defined wind loads when they were imported from text files 

and the given Story names were not correct. 

* 79289 

80051 

81014 

81185 

81656 

An incident was resolved where in some rare cases an "Error saving file." message would appear 

when trying to save the model file. This was due to editing pier assignments or adding wall objects 

after the wall design had already been run. The saved text file (.E2K, .$ET) was able to be read back 

in without any loss of data. 

 


